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Tips and Tricks for QuickBooks  
Premier Accountant 2010

In this booklet we highlight eight features that can have a positive 

impact on the methods and quality of services you provide your 

small business clients. We guide you through how to access them 

and give helpful tips and examples. 

New to QuickBooks? Access the features while in a sample company 

file provided in Premier Accountant and you will have accounting 

data to review and edit.
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1 �Works with all QuickBooks accounting software except QuickBooks Enterprise Solutions, QuickBooks Simple Start, QuickBooks for 
Mac and QuickBooks Online and requires at least QuickBooks 2009. Payroll transactions cannot be adjusted. Not all fields can be 
accessed for clients using QuickBooks 2009, including 1099 Account Mapping and Modify and Merge class lists.

Exchange and work with client accounting records
With Premier Accountant 2010 you can receive, adjust and return prior period  
accounting records from clients that use QuickBooks 2009 and 20101 editions. Here is 
how it works:

• Your client defines the prior period by setting a dividing date

• �Your client easily uploads and sends you the file via a secure connection to Intuit’s 
servers 

• You work in the prior period set by the dividing date

• ��Your client continues their work in the current period, but is locked out of the prior 
period

• �You can adjust virtually all Banking, Sales, and Customer & Vendor transactions 
plus adjust and merge the chart of accounts, adjust items and classes, and set up 
1099 account mapping

• �Your client can review and then merge your changes into the ongoing  
QuickBooks files

• �You can “Set Closing Date” when you return the file, password protecting  
access to prior periods and preserving your changes

Client creates an Accountant’s Copy:
➊  Select Accountant’s Copy and Send to Accountant from the File menu

➋  Select a date to divide the prior period from the current period in the next prompt

➌  Follow the prompts to e-mail and upload the file to a secure server

You open and use the Accountant’s Copy:
➊  You receive an e-mail notification with a link to download the client’s file

➋ � In Accountant Edition, go to the File menu and select Open or Restore 
 a Company

➌ � Follow the prompts to open, re-name and save the file

➍�  The file will open and you can review the accounting and make adjustments

Accountant’s Copy
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You export changes to your client:
➊  In Premier Accountant, 

go to the File menu, 
select Accountant’s 
Copy and then View/
Export Changes for 
Client

➋ � QuickBooks will display 
a list of your changes; 
QuickZoom© to view 
transaction details of 
your changes

➌ � From this screen you 
can add a note, print a 
copy or save a PDF of 
your changes 

➍�  Select Create Change 
File for Client to 
export your changes, then e-mail your changes to your client

To access Set Closing Date in the client’s file:
➊  Go to the Edit menu and select Preferences
➋ � From the Preferences window select Accounting and then Company Preferences 

in the display window

Client imports your changes into their file:
➊  Double-click on the .qby file.

➋ � QuickBooks will display changes and allow the client to review, print, and save your 
changes.

Accountant’s Copy

TIP �Make the “Closing Date” password your name so they know to consult 
you before adjusting prior periods. 
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Find and fix client entry errors from one screen with Client Data Review in 
QuickBooks Accountant Edition 2010. It works with company files from Pro or  
Premier 2010, and also with Accountant’s Copy files1 from QuickBooks 2009 and 
2010. Once you receive your client’s data file, you can identify entry errors and fix 
them individually or make corrections in a batch.

• Reclassify transactions in batch

• Troubleshoot and adjust account balances

• �View client changes to QuickBooks lists

• �Clear open items in A/P and A/R

• Clean up sales and payroll tax accounts

• Troubleshoot inventory discrepancies

• Write-off invoices in batch

Unlock Client Data Review2 from your client’s QuickBooks Pro or Premier 2010  
application, so you can review data at the client site. To access the tool, sign in 
with an External Accountant user name and select Client Data Review from the 
Company menu.

• �Only a user with an External Accountant login can access Client Data Review in 
non-Accountant Edition versions of QuickBooks. 

• �Accountant: you must create an External Accountant user first, or ask your client 
to create a new user for you.

1. Except the “Fix Unapplied Customers/Vendors Credits and Payments” feature.	
2. Only Client Data Review features that are available in QuickBooks Accountant Edition 2009 can be unlocked.
	

To access this feature:
➊  �Go to Accountant 

menu 
➋ � �Select Client Data 

Review

Client Data Review
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TIP �Using Toggle will NOT affect other installations of QuickBooks on your 
computer; for example, choosing to toggle to QuickBooks Pro 2010 will 
not impair your ability to use Pro 2009 if it’s installed separately on 
your computer.

Support QuickBooks clients
Premier Accountant 2010 is QuickBooks’ master program for accounting professionals. It 
contains and is compatible with your clients’ QuickBooks 2010 editions (Simple Start, Pro, 
Premier, and all industry editions).1 Toggle allows you to switch between the different 
QuickBooks 2010 accounting programs without having to maintain separate installations.

 1 �Does not include QuickBooks Enterprise Solutions, QuickBooks for Mac, QuickBooks Online.

After you’ve toggled to a different 2010 QuickBooks edition, the application title bar 
will be updated to indicate the current running edition of the software, such as 
QuickBooks Premier Professional Services 2010 (via Premier Accountant).

To access this feature:
➊  Go to the File menu 

➋ � Select Toggle to  
 Another Edition

➌ � Select the QuickBooks  
 edition you want to use

➍�  �Confirm your choice  
by clicking Toggle

Imagine... When a client calls with a “How do I?” question, you can quickly toggle to that 
edition and access the same screens and features, saving you from keeping separate 
installations of other QuickBooks editions. 

Toggle Feature
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Review and adjust account balances
Review balances, make adjusting entries, and enter workpaper references all in one place.  
The Working Trial Balance tool presents the data in a columnar format and enables you 
to QuickZoom from account balances to transaction details. 

To access this feature:
➊  �Go to the  

Accountant menu 

➋ � �Select Working  
Trial Balance

Imagine... You receive a company file from a client, and you are preparing for year-end. 
As you’re reviewing balances in the Working Trial Balance tool, you notice the current 
period transactions for inventory seem high for this client. You QuickZoom® on the 
inventory account and automatically get taken to the transaction details, where you can 
easily see the mistake. 

QuickZoom from account balances
• �Drill down from any amount to the source detail by double-clicking on an amount. 

• �If you make a change, upon returning to the Working Trial Balance, your changes 
are automatically updated. There is no separate step to refresh the data.

Working Trial Balance
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TIP �The Working Trial Balance window allows you to view any date range 
you want. Select Custom for the selected period and change the From 
and To fields to the desired period of time.

Make adjusting entries:
• Click the Make Adjustments button located at the bottom of the window. 

• �The Make General Journal Entries window appears with the Adjusting Entry 
box checked.

• �After recording the entry, the Adjustments column in the Working Trial Balance 
window is updated. Note that adjusting entries can be recorded for any date.

• You can also view a history of general journal entries made.

Enter workpaper references: 
• �Move the cursor to the desired account row and begin typing in the Workpaper 

Reference column. You can enter up to 32 characters of text. 

• �Your entry is saved when you click away from the field. Behind the scenes, the 
workpaper reference is saved with the account. The entry is retained until it is  
changed or deleted from the Working Trial Balance.

�Print trial balance: 
• �Click the Print button at the bottom of the screen to print out the data from the 

Working Trial Balance. 

• �If preferred, you can also select to print a traditional Trial Balance or Adjusted 
Trial Balance from Reports (Accountant & Taxes menu).

• �In addition, a list of the adjusting entries can be printed for use in communicating 
changes back to your client or to accompany your working papers.

Working Trial Balance
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There is a wide selection of financial reports available in Premier Accountant. They include 
balance sheet, income statement, A/P, AR, Statement of Cash Flows and Net Worth. You 
can edit and filter them to meet your needs. For example, you can modify time periods, 
fonts, numbers and account level detail. Exporting them to Microsoft® Excel1 is easy if 
you’d like to customize them further. 

1  Microsoft Excel 2003 or greater.	

To access this feature:
➊  Go to the Reports menu

➋ � �Select Company  
& Financial 	 	
 

Financial Reporting

TIP �When Control Y keys are pressed in any form (Sales Invoice, AP Bill, etc.) 
QuickBooks will show you the back-end Journal Entry in debits and credits.
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Depreciation calculations
The Fixed Asset Manager computes depreciation for up to six different asset bases, 
including book, federal, state, AMT, ACE and custom. It provides many different MACRS 
depreciation methods and performs all listed property and luxury auto calculations and 
limitations. The Fixed Asset Manager computes Section 179 expense and mid-quarter 
determinations and calculations.

From the asset record, you can choose to view a projected depreciation schedule for 
the life of the asset. The program also computes gains or losses on asset sales.

Post journal entries to QuickBooks
With the Fixed Asset Manager, you can calculate and post a depreciation journal entry.

• �From the QuickBooks menu option in Fixed Asset Manager, choose Post to  
QuickBooks General Journal 

• �Enter the date through which to compute depreciation and enter the entry 
number to be assigned with the transaction

• �Upon posting, the amounts will be recorded as an adjusting journal entry 
in QuickBooks

Manage fixed assets from acquisition to disposition
QuickBooks Fixed Asset Manager is a full-featured module that has a background of almost a 
decade of use by accountants.

Fixed Asset Manager

To access this feature:
➊ �Go to the  

Accountant menu   

➋ ��Select Manage  
Fixed Assets
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Fixed Asset Manager

Generate reports and tax worksheets
Print up to 20 reports, including asset schedules by G/L account, location, and category as 
well as property tax listings. You can also print tax worksheets for Forms 4562 and 4797. 

Transfer data between Fixed Asset List and Fixed Asset Manager
Your clients can create fixed asset items and use the Fixed Asset List to track their fixed 
assets. They can also use these items in transactions when they purchase or sell fixed 
assets. More specifically, clients can:

• �Record whether a fixed asset is new or used, the date it was purchased,  
how much it cost, and which vendor supplied it

• Keep track of fixed assets for tax purposes

• �Track important details like asset name, serial number, acquisition date,  
and disposal date

With Premier Accountant, you can review the asset data in  
Fixed Asset Tracker  

• �You have the option to pull that data directly into Fixed Asset Manager or to  
re-enter it

• �You also have the option to push data into the client’s Fixed Asset Item List from 
Fixed Asset Manager. In doing so, you can update a client’s file with depreciation 
calculations using Fixed Asset Manager and return the updated file to the client

Frequently asked questions about Fixed Asset Manager 
Q: How many assets can you set up in Fixed Asset Manager?
A: Fixed Asset Manager can support virtually an unlimited number of fixed assets.

Q: �Does Fixed Asset Manager in QuickBooks integrate with ProSeries tax software?
A: �Yes, you can import client files from ProSeries, as well as export QuickBooks 

depreciation data to automatically complete depreciation forms on the tax 
return in ProSeries Tax.

Q: How does QuickBooks data synchronize with Fixed Asset Manager?
A: �QuickBooks and Fixed Asset Manager share information while maintaining separate 

data files in separate locations. Setting the options to automatic synchronization will 
pull asset data from the QuickBooks Fixed Asset Item List when Fixed Asset Manager 
is opened or when a change is made within QuickBooks while Fixed Asset Manager 
is open. Fixed Asset Manager allows you to designate how often and when this asset 
information gets shared.

TIP �Fixed Asset Manager data is stored outside of the QBW data file. 
Backing up and restoring data is only possible from the File menu in  
Fixed Asset Manager.
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To access this feature:
➊ �Go to the Reports or 

Accountant menu

➋ �Select Intuit  
Statement Writer

➌ �Follow the prompts to 
unlock your free trial

Create professional financial statements with this Excel tool that runs exclusively 
with Premier Accountant 2010. 

• �Format changes and styles quickly with familiar Excel commands—either use a 
preset form, or change the entire style of a report with one click

• �Include real time links to your QuickBooks data that you control the with a “Refresh” 
button

• Integrate and print supporting documents created with Microsoft® Word

• Save time by easily creating financial statements in Microsoft® Excel

• Control the flow of data with one-click synch with your QuickBooks data

• �Create a custom “look” for your firm’s reports, quickly and easily—either use a 
preset form, or change the entire style of a report with one click  

• �Save time by accessing budget-to-actual and class reporting from one tool—
includes account roll-up functionality

• ��Share statements and templates by saving them to the network

Try it for free for 30 days. If you decide to purchase Intuit Statement Writer, you can 
unlock it from Premier Accountant. 

Note: Intuit Statement Writer replaces the Financial Statement Designer feature in 
previous versions of Premier Accountant. Also requires QuickBooks Premier Accountant 
2010 and Excel 2003 or 2007.

Intuit Statement Writer 2010 (sold separately)
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1 �QuickBooks Enhanced Payroll for Accountants is sold separately and requires a subscription, EIN and at least QuickBooks 2008. 
Internet access required for download delivery and Direct Deposit. Nominal additional fees apply for Direct Deposit. Checks sold 
separately. 24x7 access subject to occasional downtime due to system and server maintenance. State forms are supported for 
over 40 states. Terms, conditions, features, pricing and service options subject to change without notice.

To access this feature:
➊ �Go to the  

Reports menu

➋ �Select Client-Ready 
Payroll Reports

➌ �Select the report and  
the time period	

➍ ��Click on Create Reports

Prepare client–ready payroll reports1

With QuickBooks Enhanced Payroll for Accountants, you can print a number of payroll 
reports that are ready to deliver to your clients—with just a few keystrokes. Reports are 
preconfigured, ready to run and easily printable on standard 8 ½" x 11" paper. Help your 
clients better understand payroll with reports that cover:

• ���Payroll activity by employee

• �Payroll expense analyses

• ��Payroll tax reports

Payroll (sold separately)

To access this feature:
➊ �Go to the  

Employee menu

➋ �Select After-the- 
Fact Payroll

Perform After-the-Fact Payroll1

With Enhanced Payroll for Accountants,1 you can now efficiently enter, validate and 
adjust After-the-Fact Payroll for your clients. Use a single spreadsheet-style screen to enter 
paychecks for your clients’ employees. QuickBooks can automatically identify and adjust 
mistakes that your client may have made in calculating taxes and recommend an 
adjustment for the error.
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Need help?

�Online support resources:
• Web-based QuickBooks Support Knowledge Base—accountant.intuit.com/helpme

• QuickBooks Community on the Web—www.quickbooksgroup.com

• QuickBooks Accountant Community on the Web—accountant.intuit.com/forums

Technical support phone numbers and Web sites:
• �Call 1-800-926-6808 for free technical support for 30 days from the date of 

your software registration.1

• QuickBooks Support plans—accountant.intuit.com/helpme

�Data conversion to help your clients switch to QuickBooks:
• �Download a free tool to convert Peachtree data into QuickBooks—  

accountant.intuit.com/convert

• �Call 1-800-816-9304 for assisted data conversion from most non-QuickBooks  
programs into QuickBooks1

Want information on QuickBooks products and services for you and 
your clients?

QuickBooks products and services:
• �Information on QuickBooks products and services—www.accountant.intuit.com

• �Call 1-800-267-8379 for sales and customer service 

QuickBooks Solutions Marketplace:
• �Help your clients work more efficiently and grow their businesses with over 

400 software solutions that work seamlessly with QuickBooks

• Visit www.marketplace.intuit.com today

1 �30 consecutive days of QuickBooks 2010 support included from first-time registration. Offer valid 90 days from software 
purchase; U.S. only. Assisted data conversion includes a one-time conversion case which can be applied to multiple files. Assisted 
data conversion must be completed within 30 days from the date you register your software. 

Important Phone Numbers and Web Sites

PN 315908

accountant.intuit.com/helpme
www.quickbooksgroup.com
accountant.intuit.com/forums
accountant.intuit.com/helpme
accountant.intuit.com/convert
www.accountant.intuit.com
www.marketplace.intuit.com
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